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This chapter describes Cisco Transport Controller (CTC), the software interface for the Cisco ONS 15454.
For CTC set up and login information, refer to the Cisco ONS 15454 Procedure Guide.
Chapter topics include:
• CTC Software Delivery Methods
• CTC Installation Overview
• PC and UNIX Workstation Requirements
• ONS 15454 Connection
• CTC Login
• CTC Window
• Using the CTC Launcher Application to Manage Multiple ONS Nodes
• TCC2/TCC2P Card Reset
• TCC2/TCC2P Card Database
• Software Revert
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CTC Software Delivery Methods
ONS 15454 provisioning and administration is performed using the CTC software. CTC is a Java application
that is installed in two locations; CTC is stored on the Advanced Timing, Communications, and Control
(TCC2) card or the Advanced Timing, Communications, and Control Plus (TCC2P) card, and it is
downloaded to your workstation the first time you log into the ONS 15454 with a new software release.

CTC Software Installed on the TCC2/TCC2P Card
CTC software is preloaded on the ONS 15454 TCC2/TCC2P cards; therefore, you do not need to install
software on the TCC2/TCC2P cards. When a new CTC software version is released, use the release-specific
software upgrade document to upgrade the ONS 15454 software on the TCC2/TCC2P cards.
When you upgrade CTC software, the TCC2/TCC2P cards store the new CTC version as the protect CTC
version. When you activate the new CTC software, the TCC2/TCC2P cards store the older CTC version as
the protect CTC version, and the newer CTC release becomes the working version. You can view the
software versions that are installed on an ONS 15454 by selecting the Maintenance > Software tabs in node
view (Figure 8-1).
Figure 8-1: CTC Software Versions, Node View

CTC Software Delivery Methods
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Select the Maintenance > Software tabs in network view to display the software versions installed on all the
network nodes (Figure 8-2).
Figure 8-2: CTC Software Versions, Network View

Figure 8-1: CTC Software Versions, Node View
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CTC Software Installed on the PC or UNIX Workstation
CTC software is downloaded from the TCC2/TCC2P cards and installed on your computer automatically
after you connect to the ONS 15454 with a new software release for the first time. Downloading the CTC
software files automatically ensures that your computer is running the same CTC software version as the
TCC2/TCC2P cards you are accessing. The CTC files are stored in the temporary directory designated by
your computer operating system. You can use the Delete CTC Cache button to remove files stored in the
temporary directory. If the files are deleted, they download the next time you connect to an ONS 15454.
Downloading the Java archive (JAR) files for CTC takes several minutes depending on the bandwidth of the
connection between your workstation and the ONS 15454. For example, JAR files downloaded from a
modem or a data communications channel (DCC) network link require more time than JAR files downloaded
over a LAN connection.
During network topology discovery, CTC polls each node in the network to determine which one contains
the most recent version of the CTC software. If CTC discovers a node in the network that has a more recent
version of the CTC software than the version you are currently running, CTC generates a message stating
that a later version of the CTC has been found in the network and offers to install the CTC software upgrade
JAR files. If you have network discovery disabled, CTC will not seek more recent versions of the software.
Unreachable nodes are not included in the upgrade discovery.
Note: Upgrading the CTC software will overwrite your existing software. You must restart CTC after the
upgrade is complete.

CTC Installation Overview
To connect to an ONS 15454 using CTC, you enter the ONS 15454 IP address in the URL field of Netscape
Navigator or Microsoft Internet Explorer. After connecting to an ONS 15454, the following occurs
automatically:
1. A CTC launcher applet is downloaded from the TCC2/TCC2P card to your computer.
2. The launcher determines whether your computer has a CTC release matching the release on the ONS
15454 TCC2/TCC2P card.
3. If the computer does not have CTC installed, or if the installed release is older than the
TCC2/TCC2P card's version, the launcher downloads the CTC program files from the TCC2/TCC2P
card.
4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web
browser is no longer needed. Always log into nodes having the latest software release. If you log into
an ONS 15454 that is connected to ONS 15454s with older versions of CTC, or to Cisco ONS
15327s or Cisco ONS 15600s, CTC files are downloaded automatically to enable you to interact with
those nodes. The CTC file download occurs only when necessary, such as during your first login.
You cannot interact with nodes on the network that have a software version later than the node that
you used to launch CTC.
Each ONS 15454 can handle up to five concurrent CTC sessions. CTC performance can vary, depending on
the volume of activity in each session, network bandwidth, and TCC2/TCC2P card load.
Note: You can also use TL1 commands to communicate with the Cisco ONS 15454 through VT100
terminals and VT100 emulation software, or you can telnet to an ONS 15454 using TL1 port 3083. Refer to
the Cisco ONS SONET TL1 Command Guide for a comprehensive list of TL1 commands.

CTC Software Installed on the PC or UNIX Workstation
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PC and UNIX Workstation Requirements
To use CTC for the ONS 15454, your computer must have a web browser with the correct Java Runtime
Environment (JRE) installed. The correct JRE for each CTC software release is included on the Cisco ONS
15454 software CD. If you are running multiple CTC software releases on a network, the JRE installed on
the computer must be compatible with the different software releases.
You can change the JRE version on the Preferences dialog box JRE tab. When you change the JRE version
on the JRE tab, you must exit and restart CTC for the new JRE version to take effect. Table 8-1 shows JRE
compatibility with ONS 15454 software releases.
Table 8-1: JRE Compatibility

JRE 1.2.2
Compatible

ONS Software Release
ONS 15454 Release 2.2.1
and earlier
ONS 15454 Release 2.2.2
ONS 15454 Release 3.0
ONS 15454 Release 3.1
ONS 15454 Release 3.2
ONS 15454 Release 3.3
ONS 15454 Release 3.4
ONS 15454 Release 4.01
ONS 15454 Release 4.1
ONS 15454 Release 4.5
ONS 15454 Release 4.6
ONS 15454 Release 5.0
ONS 15454 Release 6.0
ONS 15454 Release 7.0
ONS 15454 Release 7.2
ONS 15454 Release 8.0
ONS 15454 Release 8.5

JRE 1.3
Compatible

JRE 1.4
Compatible

JRE 5.0
Compatible

Yes

No

No

No

Yes
Yes
Yes
Yes
Yes
No
No
No
No
No
No
No
No
No
No
No

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
No
No
No
No
No

No
No
No
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
No
No

No
No
No
No
No
No
No
No
No
No
No
No
Yes
Yes
Yes
Yes

1. Software Releases 4.0 and later notify you if an older version of the JRE is running on your PC or UNIX workstation.

Table 8-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java plug-in is
included on the ONS 15454 software CD.
Table 8-2: Computer Requirements for CTC

Area

Requirements

Notes
A faster CPU is recommended if your workstation runs multiple
Processor (PC Pentium 4 processor or
applications or if CTC manages a network with a large number of
only)
equivalent
nodes and circuits.
A minimum of 1 GB is recommended if your workstation runs
RAM
512 MB RAM or more multiple applications or if CTC manages a network with a large
number of nodes and circuits.
Hard drive
20 GB hard drive with CTC application files are downloaded from the TCC2/TCC2P to

PC and UNIX Workstation Requirements
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100MB of free space
required

Operating
System

your computer. These files occupy around 100MB (250MB to be
safer) or more space depending on the number of versions in the
network.

• PC: Windows
98 (1st and
2nd editions),
Windows ME,
Windows NT
4.0 with
Service Pack
6a, Windows
Check with the vendor for the latest patch/Service Pack level
2000 with
Service Pack
3, or Windows
XP with
Service Pack 1
• Workstation:
Solaris
versions 9 or
10
JRE 5.0 is installed by the CTC Installation Wizard included on the
Cisco ONS 15454 software CD. JRE 5.0 provide enhancements to
CTC performance, especially for large networks with numerous
circuits.

Cisco recommends that you use JRE 5.0 for networks with Software
R8.5 nodes. If CTC must be launched directly from nodes running
software R7.0 or R7.2, Cisco recommends JRE 1.4.2 or JRE 5.0. If
CTC must be launched directly from nodes running software R5.0 or
R6.0, Cisco recommends JRE 1.4.2.If CTC must be launched directly
from nodes running software earlier than R5.0, Cisco recommends
JRE 1.3.1_02.
For the PC, use JRE 5.0 with any supported web browser. Cisco
recommends Internet Explorer 6.x. For UNIX, use JRE 5.0 with
• PC:Internet
Explorer 6.x or Netscape 7.x or JRE 1.3.1_02 with Netscape 4.76.
Netscape 7.x
Web browser
• UNIX
Netscape 4.76 or 7.x is available at the following site:
Workstation: http://channels.netscape.com/ns/browsers/default.jsp
Mozilla 1.7,
Netscape 4.76, Internet Explorer 6.x is available at the following site:
Netscape 7.x http://www.microsoft.com
User-supplied CAT-5
straight-through cable
with RJ-45 connectors
Cable
on each end to connect the computer to the
ONS 15454 directly or
through a LAN

Java Runtime
JRE 5.0
Environment

Table 8-2: Computer Requirements for CTC
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ONS 15454 Connection
You can connect to the ONS 15454 in multiple ways. You can connect your PC directly the ONS 15454
(local craft connection) using the RJ-45 port on the TCC2/TCC2P card or the LAN pins on the backplane,
connect your PC to a hub or switch that is connected to the ONS 15454, connect to the ONS 15454 through a
LAN or modem, or establish TL1 connections from a PC or TL1 terminal. Table 8-3 lists the ONS 15454
connection methods and requirements.
Table 8-3: ONS 15454 Connection Methods

Method

Local craft

Description
Requirements
Refers to onsite network connections between the CTC
If you do not use Dynamic Host
computer and the ONS 15454 using one of the following:
Configuration Protocol (DHCP),
you must change the computer
• The RJ-45 (LAN) port on the TCC2/TCC2P card
IP address, subnet mask, and
• The LAN pins on the ONS 15454 backplane
default router, or use automatic
• A hub or switch to which the ONS 15454 is
host detection.
connected
• The ONS 15454 must be
provisioned for LAN
connectivity, including
IP address, subnet mask,
and default gateway.
• The ONS 15454 must be
physically connected to
the corporate LAN.*
The CTC computer must
be connected to the
corporate LAN that has
connectivity to the ONS
15454.

Corporate LAN

Refers to a connection to the ONS 15454 through a
corporate or network operations center (NOC) LAN.

TL1

Refers to a connection to the ONS 15454 using TL1
rather than CTC. TL1 sessions can be started from CTC,
Refer to the Cisco ONS SONET
or you can use a TL1 terminal. The physical connection
TL1 Reference Guide.
can be a craft connection, corporate LAN, or a TL1
terminal.

Remote

Refers to a connection made to the ONS 15454 using a
modem.

• A modem must be
connected to the ONS
15454.
• The modem must be
provisioned for the ONS
15454. To run CTC, the
modem must be
provisioned for Ethernet
access.

CTC Login
After you have installed CTC, you can log in to a node using your browser. To log in, you must type the
node IP address in the URL window. The CTC Login window appears.
ONS 15454 Connection
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The CTC Login window provides the following options to accelerate the login process.
• The Disable Network Discovery option omits the discovery of nodes with data communications
channel (DCC) connectivity. To access all nodes with DCC connectivity, make sure that Disable
Network Discovery is not checked. If you have network discovery disabled, CTC will not poll the
network for more recent versions of the software. (For more information about the automatic
download of the latest CTC JAR files, see the CTC Software Installed on the PC or UNIX
Workstation.)
• The Disable Circuit Management option omits the discovery of circuits. To view circuits
immediately after logging in, make sure that Disable Circuit Management is not checked. However,
if disabled, after you have logged in you can click the Circuits tab and CTC will give you the option
to enable circuit management.
These options are useful if you want to log in to a node to perform a single task, such as placing a card in or
out of service, and do not want to wait while CTC discovers DCC connections and circuits.

Legal Disclaimer
The CTC Login window currently displays the following warning message: "Warning: This system is
restricted to authorized users for business purpose. Unauthorized access is a violation of the law. This service
can be monitored for administrative and security reasons. By proceeding, you consent to this monitoring."
The ONS 15600 allows a user with Superuser privileges to modify the default login warning message and
save it to a node using the Provisioning > Security > Legal Disclaimer > HTML tab. The login warning
message field allows up to 250 characters of text (1600 characters total, including HTML markup).

Login Node Group
Login node groups display nodes that have only an IP connection. After you are logged into CTC, you can
create a login node group from the Edit > Preferences menu. Login groups appear in the Additional Nodes
list on the Login window.
For example, if you logged into Node 1, you would see Node 2 and Node 3 because they have DCC
connectivity to Node 1. You would not see Nodes 4, 5, and 6 because DCC connections do not exist. To view
all six nodes at once, you create a login node group with the IP addresses of Nodes 1, 4, 5, and 6. Those
nodes, and all nodes optically connected to them, appear when you select the login group from the Additional
Nodes list on the Login window the next time you log in.

CTC Window
The CTC window appears after you log into an ONS 15454 (Figure8-3). The window includes a menu bar, a
toolbar, and a top and bottom pane. The top pane provides status information about the selected objects and a
graphic of the current view. The bottom pane provides tabs and subtab to view ONS 15454 information and
perform ONS 15454 provisioning and maintenance. From this window you can display three ONS 15454
views: network, node, and card.
Figure 8-3: Node View (Default Login View)

CTC Login

8

ONS_15454_Reference_Manual_R8.5.x_--_Cisco_Transport_Controller_Operation

Node View
Node view, shown in Figure 8-3, is the first view that appears after you log into an ONS 15454. The login
node is the first node shown, and it is the "home view" for the session. Node view allows you to manage one
ONS 15454 node. The status area shows the node name; IP address; session boot date and time; number of
Critical (CR), Major (MJ), and Minor (MN) alarms; the name of the current logged-in user; and the security
level of the user; software version; and the network element default setup.
CTC Card Colors
The graphic area of the CTC window depicts the ONS 15454 shelf assembly. The colors of the cards in the
graphic reflect the real-time status of the physical card and slot (Table 8-4).
Table 8-4: Node View Card Colors

Card Color
Status
Gray
Slot is not provisioned; no card is installed.
Violet
Slot is provisioned; no card is installed.
White
Slot is provisioned; a functioning card is installed.
Yellow
Slot is provisioned; a Minor alarm condition exists.
Orange
Slot is provisioned; a Major alarm condition exists.
Red
Slot is provisioned; a Critical alarm exists.
The wording on a card in node view shows the status of a card (Active, Standby, Loading, or Not
Provisioned). Table 8-5 lists the card statuses.
Table 8-5: Node View Card Statuses

!Card Status !Description
Sby
Card is in standby mode.
Act
Card is active.
Figure 8-3: Node View (Default Login View)
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NP
Card is not present.
Ldg
Card is resetting.
Mis
Card is mismatched.
The port color in both card and node view indicates the port service state. Table 8-6 lists the port colors and
their service states. For more information about port service states, see Administrative and Service States.
Table 8-6: Node View Card Port Colors and Service States

Port
Color

Service State

Description

(Out-of-Service and Management, Loopback) Port is in a loopback state. On the
card in node view, a line between ports indicates that the port is in terminal or
facility loopback (see Figure 8-4 and Figure 8-5). Traffic is carried and alarm
Blue OOS-MA,LPBK
reporting is suppressed. Raised fault conditions, whether or not their alarms are
reported, can be retrieved on the CTC Conditions tab or by using the TL1
RTRV-COND command.
(Out-of-Service and Management, Maintenance) Port is out-of-service for
maintenance. Traffic is carried and loopbacks are allowed. Alarm reporting is
suppressed. Raised fault conditions, whether or not their alarms are reported, can
be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND
Blue OOS-MA,MT
command. Use OOS-MA,MT for testing or to suppress alarms temporarily.
Change the state to IS-NR, OOS-MA,DSBLD, or OOS-AU,AINS when testing
is complete.
(Out-of-Service and Management, Disabled) The port is out-of-service and
Gray OOS-MA,DSBLD
unable to carry traffic. Loopbacks are not allowed in this service state.
(In-Service and Normal) The port is fully operational and performing as
Green IS-NR
provisioned. The port transmits a signal and displays alarms; loopbacks are not
allowed.
(Out-of-Service and Autonomous, Automatic In-Service) The port is
out-of-service, but traffic is carried. Alarm reporting is suppressed. The node
monitors the ports for an error-free signal. After an error-free signal is detected,
the port stays in OOS-AU,AINS state for the duration of the soak period. After
the soak period ends, the port service state changes to IS-NR.
Violet OOS-AU,AINS
Raised fault conditions, whether or not their alarms are reported, can be retrieved
on the CTC Conditions tab or by using the TL1 RTRV-COND command. The
AINS port will automatically transition to IS-NR when a signal is received for
the length of time provisioned in the soak field.
Figure 8-4: Terminal Loopback Indicator

Figure 8-5: Facility Loopback Indicator

Table 8-5: Node View Card Statuses
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Node View Card Shortcuts
If you move your mouse over cards in the graphic, popups display additional information about the card
including the card type; the card status (active or standby); the type of alarm, such as Critical, Major, or
Minor (if any); and the alarm profile used by the card. Right-click a card to reveal a shortcut menu, which
you can use to open, reset, delete, or change a card. Right-click a slot to preprovision a card (that is,
provision a slot before installing the card).
Node View Tabs
Table 8-7 lists the tabs and subtabs available in the node view.
Table 8-7: Node View Tabs and Subtabs

Tab
Alarms
Conditions

History

Circuits

Description
Lists current alarms (CR, MJ, MN) for the node and
updates them in real time.
Displays a list of standing conditions on the node.
Provides a history of node alarms including date, type,
and severity of each alarm. The Session subtab displays
alarms and events for the current session. The Node
subtab displays alarms and events retrieved from a
fixed-size log on the node.
Creates, deletes, edits, and maps circuits and rolls.

Provisioning Provisions the ONS 15454 node.

Subtabs
-

Session, Shelf

Circuits, Rolls
General, Ether Bridge, Network,
OSI, BLSR, Protection, Security,
SNMP, Comm Channels, Timing,
Alarm Profiles, Cross-Connect,
Defaults, WDM-ANS

Provides inventory information (part number, serial
number, Common Language Equipment Identification
[CLEI] codes) for cards installed in the node. Allows you
Inventory
to delete and reset cards, and change card service state.
For more information on card service states, see
Administrative and Service States.
Database, Ether Bridge, Network,
OSI, BLSR, Protection, Software,
Cross-Connect, Overhead
Maintenance Performs maintenance tasks for the node.
XConnect, Diagnostic, Timing,
Audit, Test Access, DWDM

Network View
Network view allows you to view and manage ONS 15454s that have DCC connections to the node that you
logged into and any login node groups you have selected (Figure 8-6).
Figure 8-6: Network in CTC Network View

Node View Card Shortcuts
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Note: Nodes with DCC connections to the login node do not appear if you checked the Disable Network
Discovery check box in the Login dialog box.
The graphic area displays a background image with colored ONS 15454 icons. A Superuser can set up the
logical network view feature, which enables each user to see the same network view. Selecting a node or
span in the graphic area displays information about the node and span in the status area.
Network View Tabs
Table 8-8 lists the tabs and subtabs available in network view.
Table 8-8: Network View Tabs and Subtabs

Tab
Alarms
Conditions
History
Circuits

Provisioning

Maintenance

Description
Lists current alarms (CR, MJ, MN) for the network and updates them
in real time.
Displays a list of standing conditions on the network.
Provides a history of network alarms including date, type, and
severity of each alarm.
Creates, deletes, edits, filters, and searches for network circuits and
rolls.
Provisions security, alarm profiles, bidirectional line switched rings
(BLSRs), overhead circuits, server trails, and loads/manages a
VLAN database
Displays the working and protect software versions and allows
software to be downloaded, retrieves Open Shortest Path First
(OSPF) node information, and displays the list of automatic power

Figure 8-6: Network in CTC Network View

Subtabs
Circuits, Rolls
Security, Alarm
Profiles, BLSR,
Overhead Circuits,
Server Trails,
VLAN DB Profile
Software,
Diagnostic, APC
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control (APC) domains for a network
CTC Node Colors
The color of a node in network view, shown in Table 8-9, indicates the node alarm status.
Table 8-9: Node Status Shown in Network View

Color
Green
Yellow
Orange
Red
Gray with
Unknown#
DCC Links

Alarm Status
No alarms
Minor alarms
Major alarms
Critical alarms
Node initializing for the first time (CTC displays Unknown# because CTC has not
discovered the name of the node yet)

The lines show DCC connections between the nodes (Table 8-10). DCC connections can be green (active) or
gray (fail). The lines can also be solid (circuits can be routed through this link) or dashed (circuits cannot be
routed through this link). Circuit provisioning uses active/routable links.
Table 8-10: DCC Colors Indicating State in Network View

Color and Line Style
Green and solid
Green and dashed
Gray and solid
Gray and dashed
Link Consolidation

State
Active/Routable
Active/Nonroutable
Failed/Routable
Failed/Nonroutable

CTC provides the ability to consolidate the DCC, general communications channel (GCC), optical transport
section (OTS), provisionable patchcord (PPC), and server trail links shown in the network view. Link
consolidation allows you to condense multiple inter-nodal links into a single link. The link consolidation
sorts links by class; for example, all DCC links are consolidated together.You can access individual links
within consolidated links using the right-click shortcut menu.
Each link has an associated icon (Table 8-11).
Table 8-11: Link Icons

Icon

Description
DCC icon
GCC icon
OTS icon
PPC icon

Table 8-8: Network View Tabs and Subtabs
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Server Trail icon
Note: Link consolidation is only available on non-detailed maps. Non-detailed maps display nodes in icon
form instead of detailed form, meaning the nodes appear as rectangles with ports on the sides. Refer to the
Cisco ONS 15454 Procedure Guide for more information about consolidated links.

Card View
The card view provides information about individual ONS 15454 cards. Use this window to perform
card-specific maintenance and provisioning (Figure 8-7). A graphic showing the ports on the card is shown in
the graphic area. The status area displays the node name, slot, number of alarms, card type, equipment type,
and the card status (active or standby), card service state if the card is present, and port service state
(described in Table 8-6). The information that appears and the actions you can perform depend on the card.
For more information about card service states, see Administrative and Service States.
Figure 8-7: CTC Card View Showing a DS1 Card

Note: CTC provides a card view for all ONS 15454 cards except the TCC2, TCC2P, XCVT, XC10G, and
XC-VXC-10G cards. Provisioning for these common control cards occurs at the node view; therefore, no
card view is necessary.
Use the card view tabs and subtabs shown in Table 8-12 to provision and manage the ONS 15454. The
subtabs, fields, and information shown under each tab depend on the card type selected. The Performance tab
is not available for the Alarm Interface Controller-International (AIC-I) cards.
Table 8-12: Card View Tabs and Subtabs

Tab
Alarms

Description
Lists current alarms (CR, MJ,
MN) for the card and updates

Table 8-11: Link Icons

Subtabs
-
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Conditions
History
Circuits

them in real time.
Displays a list of standing
conditions on the card.
Provides a history of card alarms
including date, object, port, and
severity of each alarm.
Creates, deletes, edits, and search
circuits and rolls.

Session (displays alarms and events for the current
session), Card (displays alarms and events retrieved from a
fixed-size log on the card)
Circuits, Rolls
DS-N and OC-N cards: Line, Line Thresholds (different
threshold options are available for electrical and optical
cards), Elect Path Thresholds, SONET Thresholds, Alarm
Profiles

Provisioning Provisions an ONS 15454 card.
Ethernet cards (subtabs depend on the card type): Line,
Line Thresholds, Electrical Path Thresholds, SONET
Thresholds, Port, RMON Thresholds, VLAN, Card, Alarm
Profiles
DS-N and OC-N cards: Loopback, ALS, Info, Protection,
Path Trace, Bandwidth, AINS Soak
Maintenance

Performs maintenance tasks for
the card.

Performance

Performs performance monitoring
for the card.

Inventory

Displays an Inventory screen of
the ports (TXP and MXP cards
only).

Ethernet cards (subtabs depend on the card type): Path
Trace, Loopback, Allocation, AINS Soak, Ether Port Soak,
RPR Span Soak
DS-N and OC-N cards: no subtabs
Ethernet cards: Statistics, Utilization, History
-

Print or Export CTC Data
You can use the File > Print or File > Export options to print or export CTC provisioning information for
record keeping or troubleshooting. The functions can be performed in card, node, or network views. The File
> Print function sends the data to a local or network printer. File > Export exports the data to a file where it
can be imported into other computer applications, such as spreadsheets and database management programs.
Whether you choose to print or export data, you can choose from the following options:
• Entire frame-Prints or exports the entire CTC window including the graphical view of the card, node,
or network. This option is available for all windows.
• Tabbed view-Prints or exports the lower half of the CTC window containing tabs and data. The
printout includes the selected tab (on top) and the data shown in the tab window. For example, if you
print the History window Tabbed view, you print only history items appearing in the window. This
option is available for all windows.
1.

♦ Table Contents-Prints or exports CTC data in table format without graphical representations
of shelves, cards, or tabs. The Table Contents option prints all the data contained in a table
with the same column headings. For example, if you print the History window Table
Contents view, you print all data included in the table whether or not items appear in the
window.

Table 8-12: Card View Tabs and Subtabs
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1.

The Table Contents option does not apply to all windows; for a list of windows that
do not support print or export, see the Cisco ONS 15454 Procedure Guide.

Using the CTC Launcher Application to Manage Multiple ONS Nodes
The CTC Launcher application is an executable file, StartCTC.exe, that is provided on Software Release 8.5
CDs for Cisco ONS products. You can use CTC Launcher to log into multiple ONS nodes that are running
CTC Software Release 3.3 or higher, without using a web browser.
CTC Launcher provides two connection options. The first option is used to connect to ONS network
elements (NEs) that have an IP connection to the CTC computer. The second option is used to connect to
ONS NEs that reside behind third party, OSI-based gateway network elements (GNEs). For this option, CTC
Launcher creates a TL1 tunnel to transport the TCP traffic through the OSI-based GNE.
The TL1 tunnel transports the TCP traffic to and from ONS ENEs through the OSI-based GNE. TL1 tunnels
are similar to the existing static IP-over-CLNS tunnels, GRE and Cisco IP, that can be created at ONS NEs
using CTC. (Refer to the Cisco ONS product documentation for information about static IP-over-CLNS
tunnels.) However, unlike the static IP-over-CLNS tunnels, TL1 tunnels require no provisioning at the ONS
ENE, the third-party GNE, or DCN routers. All provisioning occurs at the CTC computer when the CTC
Launcher is started.
Figure 8-8 shows examples of two static IP-over-CLNS tunnels. A static Cisco IP tunnel is created from ENE
1 through other vendor GNE 1 to a DCN router, and a static GRE tunnel is created from ONS ENE 2 to the
other vender, GNE 2. For both static tunnels, provisioning is required on the ONS ENEs. In addition, a Cisco
IP tunnel must be provisioned on the DCN router and a GRE tunnel provisioned on GNE 2.
Figure 8-8: Static IP-Over-CLNS Tunnels

Figure 8-9 shows the same network using TL1 tunnels. Tunnel provisioning occurs at the CTC computer
when the tunnel is created with the CTC Launcher. No provisioning is needed at ONS NEs, GNEs or routers.

Print or Export CTC Data
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Figure 8-9: TL1 Tunnels

TL1 tunnels provide several advantages over static IP-over-CLNS tunnels. Because tunnel provisioning is
needed only at the CTC computer, they are faster to set up. Because they use TL1 for TCP transport, they are
more secure. TL1 tunnels also provide better flow control. On the other hand, IP over CLNS tunnels require
less overhead and usually provide a slight performance edge over TL1 Tunnels (depending on network
conditions). TL1 tunnels do not support all IP applications such as SNMP and RADIUS Authentication.
Table 8-13 shows a comparison between the two types of tunnels.
Table 8-13: TL1 and Static IP-Over-CLNS Tunnels Comparison

Category

Static
IP-Over-CLNS

TL1
Tunnel

Comments

Requires provisioning at ONS NE, GNE, and DCN
Simple
routers. For TL1 tunnels, provisioning is needed at CTC
computer.
Static tunnels generally provide better performance than
TL1 tunnels, depending on TL1 encoding used.
Average to
LV+Binary provides the best performance. Other
good
encoding will produce slightly slower TL1 tunnel
performance.
TL1 tunnels do not support SNMP or RADIUS Server
No
IP applications.
Only the static IP-over-CLNS tunnels meet ITU
No
standards. TL1 tunnels are new.

Setup

Complex

Performance

Best

Support all IP
applications

Yes

ITU Standard

Yes

Tunnel traffic
control

Good

Very good Both tunnel types provide good traffic control

Complex

No setup
needed

Security setup

Static IP-over-CLNS tunnels require careful planning.
Because TL1 tunnels are carried by TL1, no security
provisioning is needed.

Possible
Figure 8-9: TL1 Tunnels
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Potential to breach
DCN from DCC
using IP.
IP route
management

Not
possible

Expensive

Flow control
Weak
Bandwidth sharing
among multiple
Weak
applications

A potential exists to breach a DCN from a DCC using
IP. This potential does not exist for TL1 tunnels.

For static IP-over-CLNS tunnels, route changes require
Automatic manual provisioning at network routers, GNEs, and
ENEs. For TL1 tunnels, route changes are automatic.
Strong
TL1 tunnels provide the best flow control.
Best

-

TL1 tunnels are terminated when the CTC session ends.
Static IP-over-CLNS tunnels exist until they are deleted
in CTC.
TL1 tunnel specifications and general capabilities include:
Tunnel lifecycle

Fixed

CTC
session

• Each tunnel generally supports between six to eight ENEs, depending on the number of tunnels at the
ENE.
• Each CTC session can support up to 32 tunnels.
• The TL1 tunnel database is stored locally in the CTC Preferences file.
• Automatic tunnel reconnection when the tunnel goes down.
• Each ONS NE can support at least 16 concurrent tunnels.

TCC2/TCC2P Card Reset
You can reset the ONS 15454 TCC2/TCC2P card by using CTC (a soft reset) or by physically reseating a
TCC2/TCC2P card (a hard reset). A soft reset reboots the TCC2/TCC2P card and reloads the operating
system and the application software. Additionally, a hard reset temporarily removes power from the
TCC2/TCC2P card and clears all buffer memory.
You can apply a soft reset from CTC to either an active or standby TCC2/TCC2P card without affecting
traffic. If you need to perform a hard reset on an active TCC2/TCC2P card, put the TCC2/TCC2P card into
standby mode first by performing a soft reset.
Note: When a CTC reset is performed on an active TCC2/TCC2P card, the AIC-I cards go through an
initialization process and also reset because AIC-I cards are controlled by the active TCC2/TCC2P.

TCC2/TCC2P Card Database
When dual TCC2/TCC2P cards are installed in the ONS 15454, each TCC2/TCC2P card hosts a separate
database; therefore, the protect card database is available if the database on the working TCC2/TCC2P fails.
You can also store a backup version of the database on the workstation running CTC. This operation should
be part of a regular ONS 15454 maintenance program at approximately weekly intervals, and should also be
completed when preparing an ONS 15454 for a pending natural disaster, such as a flood or fire.
A database backup may be restored in two ways, partial or complete. A partial database restore operation
restores only the provisioning data. A complete database restore operation restores both system and
provisioning data. For more information on restoring a database, refer to the Cisco ONS 15454 Procedure
Guide.
Note: The following parameters are not backed up and restored: node name, IP address, mask and gateway,
and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up
Table 8-13: TL1 and Static IP-Over-CLNS Tunnels Comparison
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database with a different node name, the circuits map to the new node name. Cisco recommends keeping a
record of the old and new node names.
Note: To avoid a node IP and secure IP ending up in the same domain after restoring a database, ensure that
the node IP stored in the database differs in domain from that of the node in repeater mode. Also, after
restoring a database, ensure that the node IP and secure IP differ in domain.

Software Revert
When you click the Activate button after a software upgrade, the TCC2/TCC2P copies the current working
database and saves it in a reserved location in the TCC2/TCC2P flash memory. If you later need to revert to
the original working software load from the protect software load, the saved database installs automatically.
You do not need to restore the database manually or recreate circuits.
Note: The TCC2/TCC2P card does not carry any software earlier than Software R4.0. You will not be able to
revert to a software release earlier than Software R4.0 with TCC2/TCC2P cards installed.
The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You can
revert to the protect software load without losing traffic. When the next maintenance window opens,
complete the upgrade and activate the new software load.
Circuits created and provisioning done after a software load is activated (upgraded to a higher software
release) will be lost with a revert. The database configuration at the time of activation is reinstated after a
revert. This does not apply to maintenance reverts (for example, 4.6.2 to 4.6.1), because maintenance releases
use the same database.
To perform a supported (non-service-affecting) revert from Software R8.5, the release you want to revert to
must have been working at the time you first activated Software R8.5 on that node. Because a supported
revert automatically restores the node configuration at the time of the previous activation, any configuration
changes made after activation will be lost when you revert the software. Downloading Release 8.5 a second
time after you have activated the new load ensures that no actual revert to a previous load can take place (the
TCC2/TCC2P card will reset, but will not be traffic affecting and will not change your database).

TCC2/TCC2P Card Database
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